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Windows Troubleshooting Guide for 
ImagePrint v13 BLACK and ImagePrint 

R.E.D. 
Updated November 2025 

Despite our best efforts, when computers, software, printers and color management come 

together, somewhere along the line problems may occur. This guide will help to solve the 

majority of issues that users run into as well as answer common questions regarding the use of 

ImagePrint BLACK v13 and ImagePrint R.E.D. v13. 

Note: This guide is designed for users of ImagePrint v13 BLACK and R.E.D. and may not apply to 

earlier versions of the software. Users of previous versions can access trouble-shooting in the 

back of their user’s manual or as a separate PDF file within their ImagePrint folder. 

 

 

ImagePrint v13 Black/R.E.D. are compatible with Windows 10 (64-bit versions) and Windows 11. 
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Contacting Technical Support  
Most issues with ImagePrint can be solved by consulting this Troubleshooting guide, however, 

there are times you need a helping hand to get past some problems. For that, there’s 

ColorByte’s technical support department.  

ImagePrint R.E.D. comes with 90 days email support.  

ImagePrint Black comes with 1 year email and phone support.  

ColorByte’s email support is among the best in the business, and responses are typically quick 

and accurate. (In fact, email response times are often much quicker than those for phone calls). 

Please consult the following guidelines when corresponding with our support dept. to receive a 

solution to your problem more quickly. ColorByte’s support dept. can be reached via an email 

link by going to www.colorbytesoftware.com and choosing the Support and then IP RED or IP 

BLACK menus at the top of the screen. You can also email support directly at: 

imageprint_support@colorbytesoftware.com. Please remember: If you are not on the current 

version of ImagePrint or under a maintenance contract you may no longer be eligible for 

support. If unsure of your support status, please contact the ColorByte Sales dept. at 

imageprint_sales@colorbytesoftware.com. 

 

http://www.colorbytesoftware.com/
mailto:imageprint_support@colorbytesoftware.com
mailto:imageprint_sales@colorbytesoftware.com


Page 3 of 45 
 

Emailing ColorByte Support  

When emailing ColorByte Support, always include the following information:  

• Your name and 6-digit number from your ImagePrint dongle 

• The printer you are using and how the computer is connected to it.  

• The version and build number of ImagePrint (this can be found by choosing “About” under the 

ImagePrint HELP menu)  

• The platform (Mac or PC) and the OS (i.e., MacOS 13.2, or Windows 11). 

• A brief (but detailed) description of the problem you are having. Make sure to include any 

error messages exactly as they appear (please email the screen grab of the entire SpoolFace 

window if the error is reported there). Some questions you may wish to include answers for are: 

- Is this a brand-new installation of ImagePrint on this computer?  

- Has anything changed on your system prior to the problem?  

- How are you connected to the printer?  

- Have you reproduced the problem, or did it just happen once?  

- Does the problem only happen with certain images? (If possible, try printing the “sample 

portrait.tif” image that is located in the Test Images folder in C:\ProgramData\Colorbyte 

Software\ImagePrint 64bit folder as a test.) 

- What have you already done to try to correct the problem? 

Other Information that may be helpful to include in the email:  

• Job File: - This is typically the most valuable diagnostic information we can receive if you are 

emailing about a problem related to printing. Job files are the files sent to SpoolFace when you 

click PRINT and contain all the information about that print job.  

To get a job file: 

- In SpoolFace, move the failed print job from the Active Jobs down into the Saved Jobs (unless 

it was already moved there automatically). 

- Double-click the failed job--a text window will appear 

- Highlight all of the text in the window (scroll down to get it all) 

- Copy and paste this information into your email. 
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Things not to include in a support email  

• Vague or very general information, such as “I get an error”, without specifying what it is. 

These types of emails require another round of emails as we ask for specifics.  

• Pricing and sales questions. Our support department is not able to answer specific questions 

on pricing. Those are best sent to our sales dept. at: imageprint_sales@colorbytesoftware.com 

Support Availability  

Colorbyte Technical Support is available during regular business hours: 9:00 am to 5:00 pm, 

Eastern Standard Time. Most emails are responded to within 2 hours of receipt (often much 

more quickly) however volume received and other factors may affect response times. If you 

have not received a response within 24 hours, please resend the email.  

If you are no longer using the current version of ImagePrint, you may no longer be eligible for 

support. If you are not on the current version of ImagePrint or under a maintenance contract 

you may receive an automatic response from support detailing your support options. 

 

Where can I go to learn more about ImagePrint?  

Training Movies: The numerous training movies can be located via ImagePrint Video Tutorials 

link on the Support page on our web site: www.colorbytesoftware.com. 

Workshops, trade shows, seminars: While ColorByte doesn’t currently produce workshops or 

seminars, there are existing ones that utilize and teach with ImagePrint. Also, ColorByte 

personnel sometimes appear at industry trade shows or participate in dealer seminars. For 

information on upcoming events in your area, contact the sales department at: 

imageprint_sales@colorbytesoftware.com  

Updates: Choose Check for Updates from ImagePrint’s HELP menu to update the software to 

the latest revision. If you need to reinstall, or install on a new system, the latest build of 

ImagePrint R.E.D. or ImagePrint BLACK can be found at the ColorByte web site via the following 

links:  

http://print-red.info  

http://print-black.info 

 

 

mailto:imageprint_sales@colorbytesoftware.com
http://www.colorbytesoftware.com/
mailto:imageprint_sales@colorbytesoftware.com
http://print-red.info/
http://print-black.info/
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Which Windows versions are ImagePrint v13 R.E.D. and 

Black compatible with?  
ImagePrint v13 Black/R.E.D. are compatible with Windows 10 (64-bit versions) and Windows 11. 
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Installation, Uninstallation Issues  
This section is devoted to issues related to installing or uninstalling ImagePrint. 

Installer fails to complete 

If the Installer fails or never launches, check the following for possible causes and solutions: 

Anti-Virus software: Failure to complete the installation may be caused by Virus detection 

software. It is strongly recommended that you disable any anti-virus software during 

installation. RIP software, such as ImagePrint, alters system files in ways that often seem 

suspicious to anti-virus software and may trigger blocking or quarantining of necessary files. If 

anti-virus software is enabled during installation of ImagePrint, make sure to ALLOW any 

components the anti-virus software may prompt you to block. 

An older version of ImagePrint was not removed: v13 can be installed on top of v12.1 only. If 

you attempt to install v13 without removing v12 or older, v13 installer will fail. Use Windows 

Settings -> Apps -> Installed Apps to uninstall older version of ImagePrint, restart the computer 

and then run v13 installer again. 

Can’t uninstall ImagePrint  

To uninstall ImagePrint, make sure the print queue in the SpoolFace was paused (if there is a 

stuck job at the top of the Active Jobs section), close ImagePrint and SpoolFace, restart the 

computer. Then, go to Windows Settings -> Apps -> Installed Apps. You’ll see ImagePrint 

R.E.D./Black in the list – click on it and select to uninstall. You’ll be prompted to Repair or 

Uninstall. Choose Uninstall to remove the software. You’ll be given a choice to remove User 

settings and spooler files as part of the uninstall process--if you choose to remove those files, 

old jobs and settings will not be preserved if you reinstall ImagePrint later. 

How do I update/upgrade my software?  

Already on ImagePrint v13 R.E.D. or BLACK?  

Updating ImagePrint v13 R.E.D. or Black is easy. The latest update of ImagePrint is always 

available from within the software via the Help -> Check for Updates command in the Main 

menu. If, for some reason, the UPDATE process does not work (or you are not connected to the 

internet on your ImagePrint computer) you can manually download the current ImagePrint 

Installer and apply it. Running the v13 Installer on top of a current installation of ImagePrint v13 

R.E.D. or Black will update it to the latest revision without affecting your settings or job files. To 

get the latest installer, go to www.colorbytesoftware.com and choose SUPPORT, then IP RED or 

IP Black from the menu at the top of the screen. Look for the downloads link at the top of the 

Support page. 

http://www.colorbytesoftware.com/
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Upgrading from an older version of ImagePrint?  

!! IMPORTANT: Do not upgrade to ImagePrint v13 BLACK or R.E.D. if you do not already have an 

ImagePrint v13 license for the new version or the software will run in demo mode (putting the 

word DEMO on your prints). Please contact the ColorByte sales dept. at 

imageprint_sales@colorbytesoftware.com with your 6-digit dongle number for information and 

pricing on upgrading to Black or R.E.D. 

- Upgrading from ImagePrint Black/R.E.D. v12.1 to ImagePrint Black/R.E.D. v13: To upgrade you 

can use the ImagePrint v13 R.E.D./Black installer--it will update the software to ImagePrint v13 

while attempting to preserve old job files and your installed printer(s) though some settings may 

need to be reapplied. To get the latest installer, go to www.colorbytesoftware.com and choose 

SUPPORT, then IP BLACK from the menu at the top of the screen. When on the Support page for 

IP Black look for the downloads link at the top.   

- Upgrading from ImagePrint Black v12 or earlier to ImagePrint BLACK v13: Upgrading on top of 

such old version is not supported on Windows. You must remove the old ImagePrint version 

prior to installing ImagePrint v13 BLACK. Go to Windows Settings -> Apps -> Installed Apps, 

select and uninstall old ImagePrint Black. Then install ImagePrint BLACK v13 using the 

instructions in your ImagePrint Black shipment or download email.  

- Upgrading from earlier versions of ImagePrint to ImagePrint v13 R.E.D You cannot update 

older versions of ImagePrint to ImagePrint v13 R.E.D. ImagePrint v13 R.E.D. requires a clean 

install. Follow the uninstall instructions in your ImagePrint User’s Manual for the version of 

ImagePrint. Then install ImagePrintv13 R.E.D. using the instructions in your ImagePrint v13 

R.E.D. shipment or download email. 

Networked Printer Setup -- Getting your Printer’s IP Address  

For some printers you will need to provide the IP Address of the printer to IPSetup during 

installation so ImagePrint can communicate with it at print time. You can usually find the ip-

address from the printer--although different printers vary in the exact steps, some method of 

accessing the ip address will be available.  

Front Panel: Most printers allow you to see or print the IP Address via the front panel controls 

on the printer. Consult your printer’s manual for instructions for how to do this.  

Status Page – for older printers with an optional Ethernet card: In cases where you are not able 

to use the front panel to find the IP Address, check for a small or recessed button beside the 

port where the network cable plugs into the printer. Pushing this button for one second will 

cause most printers to output a page showing their current settings, including the IP Address. 

(Make sure to load scrap paper on the printer--not expensive art paper!)  

mailto:imageprint_sales@colorbytesoftware.com
http://www.colorbytesoftware.com/
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Checking TCP/IP connectivity  

Once you have the printer’s IP Address, type it into the address field of a web browser (like 

Internet Explorer, Chrome, Edge or Firefox). Just type the 4 numbers of the ip address, 

separated by periods, into the address field--no other text (like http://) is needed. You should 

see the Printer’s HTML setup screen. Using a web browser in this way is a good test of your 

computer’s TCP/IP connectivity to the printer--if the browser fails to show the printer’s setup 

screen, then you know you have a TCP/IP communications problem and ImagePrint will not be 

able to reach the printer using this ip address. 
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License, Dongle and Demo Mode Issues 
ImagePrint licensing questions, problems and solutions are listed in this section  

How do I get my license code?  

In order to enable your software to print in non-demo mode, you must first license it. Licensing 

is done via a license (sometimes called “encryption”) code that is 19 to 20 digits in length with a 

letter at the end. This code is specially made for your unique dongle number and the printer(s) 

you are using with a specific version of ImagePrint. It can be entered into the LICENSE field of 

IPSetup when installing the printer or entered later by launching IPSetup and clicking the 

LICENSE PRINER button. In IPSetup your printer will be labeled as “Licensed” and you’ll be ready 

to print.  

To get your license code, you must use the ColorByte license server web page. This server is 

available on the internet 24 hours a day, 7 days a week. To use the ColorByte license server you 

will need 3 things:  

1. Your unique 6-digit dongle number. This number is provided on the dongle itself, as well as on 

the label on the back of the dongle case. It will also be listed in any upgrade emails you receive 

from ColorByte.  

2. The 6-letter login ID for each printer type you will be using with ImagePrint. This login ID can 

be found in your ImagePrint shipment or in the upgrade email you received from ColorByte. 

Remember--login IDs are specific to the version of ImagePrint you are using--do not use an 

older login ID to get a license number for a later version of ImagePrint or you will just re-receive 

the previous versions license code and it will fail to license the software. If installing multiple 

printers, you’ll get a separate license for each printer size but-- if you have purchased multiple 

printer licenses for the same size of printer (for example, two 17 inch printers such as a Canon 

Pro 1000 and an Epson 5000) then you will be provided one single login ID that is good for two 

printers.  

3. A valid email address  

Log on to the ColorByte license server by going to www.colorbytesoftware.com and choosing 

either IP RED or IP BLACK from the menu at the top, then click on “Activate Software” to access 

the license activation web page. You will be taken to a page containing fields for the 6-digit 

dongle number, the 6-letter login ID, and the email address the license number should be sent 

to. After filling out those fields, click Submit to have the license number emailed to you. You will 

usually receive the email within 1 minute. Also, the next page will display your license code[s] 

below “Thank You” message. If you don’t receive the email: Check for any junk mail filters on 

http://www.colorbytesoftware.com/
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your computer or in use by your Internet Service provider---in almost all cases, instances where 

the encryption email is not received are due to it being misinterpreted as junk (spam) mail by 

such systems.  

There is no limit to the number of times you can use the encryption server, and you can use it 

with a different email address if you have problems with your original email one. Just make sure 

to use the right login ID for your version of ImagePrint (i.e., don’t use your version 10.0 login ID 

if installing version 13 BLACK). 

 

The Dongle number is not seen in IPSetup. “NO DONGLE FOUND” displayed at 

the top.  

If the 6-digit dongle number does not appear at the top of IPSetup, try plugging the dongle into 

a different USB port, or a USB hub if available. Make sure to quit and restart IP Setup after trying 

a different port so it will recheck for the dongle. Next try restarting the computer and launching 

IPSetup again. 

Important: When upgrading from version 11 or older, please note, older dongles may not work 

with 64-bit version 13. In that case the dongle may need to be exchanged. Please visit 

https://www.colorbytesoftware.com/IMAGEPRINT_64DongleUpdate_Win.shtml to download 

the Dongle Checker to test the dongle and for the dongle upgrade instructions. If you have 

questions about the Dongle Checker, please contact ColorByte Support at 

imageprint_support@colorbytesoftware.com for more information. If you have questions about 

the shipping and payment options, please contact ColorByte Sales at 

imageprint_sales@colorbytesoftware.com. 

Regarding the dongle light. The red dongle “pin hole” light does not stay on all the time so not 

seeing the light is not necessarily an indication that the dongle is malfunctioning. 

If the dongle number still fails to appear after trying a different port and restarting computer, 

there may be a problem with the Windows dongle driver. Sometimes Windows will attempt to 

put its own driver in place when it senses the dongle and that can cause issues. Navigate to 

C:\Program Files\ImagePrint\license\marx folder, double-click on CBUSetup.exe located there 

and select to Uninstall (if this option is available), then launch CBUSetup again and select to 

Install the driver. If Uninstall option was not available, select Repair or simply Install. 

Another thing to try: it’s possible in some cases that the dongle contacts have developed an 

oxidized coating on their contacts preventing a solid connection to the computer. You can take a 

small flat head screw driver--or even an unfolded, sturdy paperclip--and vigorously scratch the 4 

https://www.colorbytesoftware.com/IMAGEPRINT_64DongleUpdate_Win.shtml
mailto:imageprint_support@colorbytesoftware.com
mailto:imageprint_sales@colorbytesoftware.com
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contacts visible within the opening of the dongle where it plugs into the computer. In several 

cases that has brought a seemingly dead dongle to life. 

If none of the above attempts cause the dongle to be seen in IPSetup, the dongle may have 

malfunctioned (this is rare, but can happen due to physical or electronic damage). Contact 

ColorByte at imageprint_sales@colorbytesoftware.com or your ImagePrint dealer in this case. 

NOTE: Until the dongle number can be seen by the computer your license can not be 

successfully entered. Without a license, the software will either run in DEMO mode (printing 

DEMO on all output) or will not print at all! 

My license code doesn’t work when I enter it in IPSetup  

The IPSetup program is used to both set up and license your printers. If, after entering your 

license code the installed printer(s) don’t show as LICENSED in IP Setup, check the following:  

1. Make sure the 6-digit dongle number is showing in the IPSETUP window. If the dongle is not 

detected, then the system is not currently seeing the dongle. Check the entry in this guide 

titled: The Dongle number is not seen in IPSetup. “NO DONGLE FOUND” displayed at the top. 

2. If the dongle number is showing up correctly in IPSetup, but the printer still won’t license, 

check each of the following points:  

• Make sure you are using the right license for your version of ImagePrint. If updating from a 

previous version, typically, the new license retrieval information is included when you receive 

your upgrade information via email. (Do not use your old login ID to receive your license 

number from ColorByte’s activation web page, as it will just send you the old version’s license 

again!)  

• If you receive NO error message but the printer doesn’t show LICENSED at the end of the 

printer line in IP Setup after entering the license code, try deleting the file “ip_auth”, from its 

location in the ImagePrint DATA folder on your system. You can get to the DATA folder via the 

shortcut in the COLORBYTE SOFTWARE program group listed in your Windows Start Menu on 

navigate to C:\ProgramData\Colorbyte Software\ImagePrint 64bit folder. Once you have deleted 

the ip_auth file, try to LICENSE the printer again via IPSetup.  

• If you have more than one printer, make sure to try all of the licenses you have received. 

IPSetup will automatically apply the correct license code to the installed printer it was created 

for. If that printer type has not been installed yet, the license will be stored and automatically 

applied when the printer is installed.  

DEMO appears on all prints or NOTHING prints with red license error messages 

appearing in the right (Log) section of SpoolFace  

mailto:imageprint_sales@colorbytesoftware.com


Page 12 of 45 
 

“DEMO” mode occurs when the dongle is not “seen” by the computer and/or the proper printer 

license not being in place. In DEMO mode, NOTHING will print if you are currently set to “Do 

Not Print if Demo” mode under SpoolFace’s QUEUE -> Demo Behavior menu, or you’ll see a 

DEMO watermark on all of your output if set to “Do Print in Demo” under SpoolFace’s QUEUE -> 

Demo Behavior menu.  

Always check SPOOLFACE’s Log area, on the right side, for licensing messages (typically in RED) 

to confirm this condition).  

If you do see messages in SpoolFace that refer to licensing or dongle issues:  

1. Make sure that an ImagePrint dongle is attached to your computer and is detected by 

IPSetup. You may want to try plugging the dongle into another USB port, or a USB hub. You can 

check to see if the dongle is being seen by launching the IPSetup program from the ImagePrint 

folder, and checking that the 6-digit dongle number appears at the top of the window. If it 

doesn’t, see the earlier section (The Dongle is not seen in IPSetup) on resolving issues with the 

dongle not being detected.  

2. Make sure that a valid license has been entered in the IPSetup utility. If, even after entering 

the license number, the installed printer(s) doesn’t show as LICENSED, see the entry in this 

guide entitled: License doesn’t work in IPSetup.  

3. If the dongle is connected to your computer or USB hub, the printer has been licensed in 

IPSetup, and DEMO still appears on prints, double-check in IP Setup that the dongle is still seen. 

(Sometimes, plugging other USB devices in or unplugging them can cause the dongle to not be 

seen temporarily).  

4. If none of the above suggestions apply, contact ImagePrint support by emailing 

imageprint_support@colorbytesoftware.com (see the earlier section on how to report an 

issue). 

 

 

 

 

 

 

mailto:imageprint_support@colorbytesoftware.com
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Problems starting or using ImagePrint  
Problems related to launching or using the ImagePrint interface are listed in this section  

ImagePrint won’t launch 

- Make sure that you have set up your printers using the IPSetup utility. You can double-

check your installation by launching IPSetup from the ImagePrint folder on your system. 

(C:\ProgramFiles\ImagePrint on Windows). If no printers are listed, then none have been 

installed and ImagePrint will fail to launch. 

- Make sure that the ImagePrint folder has not been moved or renamed. This folder must 

retain the same name and location as it had after installation or the software will not 

run. 

- Make sure that you are launching the application from either a valid shortcut in 

Windows Start menu or directly from the ImagePrint folder. Do NOT move ImagePrint’s 

application files to a different location other than the folder they were installed to or 

they will NOT work. 

- An invalid or corrupt monitor profile may cause this condition. If you’ve profiled your 

monitor recently test this by accessing your Windows Settings, choose Display, then 

Settings, then Advanced, and temporarily change the System Monitor profile to a 

standard working space (such as Adobe 1998). Remember the previous profile so you 

can return to it later. Then try launching ImagePrint again. If it works, there is an issue 

with your monitor profile. Try reprofiling or using another monitor profile. 

Some ImagePrint windows or SpoolFace not appearing when chosen  

Display Change: If you are using a new monitor with a different resolution, or have 

recently changed the resolution on your current monitor, or have gone from two monitors down 

to one, it’s possible that the window is being placed outside of your current displayed area. To 

fix the problem, temporarily reset your monitor to the old resolution and then manually move 

the windows back into range.  

A quick fix may be simply to launch ImagePrint, and under the VIEW menu choose 

“Reset Window Positions”. That will return all of the ImagePrint windows to their default 

locations.  

If a change in your display is definitely not the problem, or it is not possible to go back to 

your previous display configuration, you may need to delete ImagePrint’s Registry key. Note: 

deleting this key will revert most ImagePrint settings back to their defaults. Make sure that 

ImagePrint and Spoolface are NOT running before deleting the registry key. Launch Windows 
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Registry Editor and delete ImagePrint or SpoolFace folder from 

Computer\HKEY_CURRENT_USER\SOFTWARE\Colorbyte Software. 

Files won’t open  

The most common problem with images failing to open is due to an illegal character in the file 

name OR THE NAME OF ANY OF THE FOLDER(S) (also known as the PATH) THAT THE FILE IS IN. 

For example: if your file is called test.tif, and it’s in the following folder path:  

/ my files / images / photo group #2 / vacation pics / test.tif  

The “#” in “photo group #2” would prevent any files within the above path from opening. Check 

the name of the file (and every folder and sub-folder along the file’s path) for any character that 

is not a letter, number, underline, hyphen or space. Check the entire path of folders--any 

problem character in any folder in the file path will cause the image not to open. Problem 

characters include (but are not restricted to): parenthesis (), pound signs #, apostrophes ‘, 

amper sands &, commas , , dollar signs $ and bullets •. Also--make sure your files have the 

proper extensions in the file name for their format. (.tif (or .tiff), .pdf, .psd, .jpg) or they will not 

be recognized as image files by ImagePrint. As a test, try renaming your file to a simple name 

(i.e., test.tif, test.jpg or test.psd) and move it to your local computer’s desktop. Then try to open 

it in ImagePrint. If it opens, then either something in the filename or pathname is causing an 

issue, or permissions on the original folder or drive the image was located in was the culprit.  

If the image still fails to open, check the sections of this guide pertaining to problems with the 

file type you are working with (JPEG, PSD or TIFF). Remember that ImagePrint only opens JPEG 

(RGB only), PDF, PNG, PSD and TIFF files. Other formats such as PostScript, EPS, GIF, or Raw files 

are not supported. 

JPEG files won’t open (or open very slowly)  

Try re-saving the JPEG file from Photoshop, and make sure NOT to use “PROGRESSIVE” 

as the JPEG compression format in the SAVE dialog. Also, only RGB JPEG files are supported (not 

CMYK JPEG files). 

JPEG files are opening and printing at the wrong size!  

ImagePrint will honor the width/size parameters of a jpeg file. Sometimes, however, JPEG files 

don’t have that information (usually this happens when JPEG files are saved straight from a 

camera without being saved out through an editing application like Photoshop). In those cases, 

ImagePrint will default to using 300ppi when opening a file. You can always quickly resize the 

image via the Width/ Height fields at the top of the ImagePrint Layout window, or drag an edge 
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of the image to resize it dynamically. Or use one of the automatic sizing options like “Fit to 

Page” in the Toolbar. 

TIFF files won’t open (or open very slowly)  

• Make sure to check the general question regarding File Names earlier in this document--

nothing but letters, spaces, underlines, hyphens and periods should be in the file name.  

• LAYERS: ImagePrint cannot guarantee support for Photoshop layers. Many layers work fine, 

but if you have problems opening or printing tiff files, the first thing to do is flatten the image to 

remove any layers.  

• The Pixel Order can also cause images not to open, or to open and display incorrectly or to 

open and print very slowly. In Photoshop’s “Save As...” dialog, in the TIFF options section, make 

sure the Pixel Order is always INTERLEAVED, never “Per Channel”.  

• Additional Channels: ImagePrint does not support non-color channels in TIFF files. Make sure 

that no extra channels are present in your image. To check for extra channels, open the file in 

Photoshop. Choose CHANNELS under the Photoshop Windows menu. In the Channels palette 

that appears, you should only see the standard color channels (i.e., R,G,B for an RGB image). 

Delete any extra channels and save a copy of your image for printing. 

PSD (Photoshop) files won’t open (or print slowly)  

• Make sure to check the general question regarding File Names earlier in this document--

nothing but letters, spaces, underlines, hyphens and periods should be in the file name  

• LAYERS: ImagePrint cannot guarantee support for Photoshop layers. Many layers work fine, 

but if you have problems opening or printing psd files, the first thing to do is flatten the image 

to remove any layers. 

• Also, make sure that no extra (non-color) channels exist in the image. To check for extra 

channels, open the file in Photoshop. Choose CHANNELS under the Photoshop Windows menu. 

In the Channels palette that appears, you should only see the standard color channels (i.e., 

R,G,B for an RGB image). Delete any extra channels and save a copy of your image for printing.  

• Try saving the file as a TIFF, or JPEG to avoid any issues with the Photoshop image format 

(which can sometimes have Photoshop specific information that doesn’t work well with non-

Adobe applications) 

The Profile Valet doesn’t show any profiles! (ImagePrint BLACK only)  

1. The Profile Valet does not work with some older printers due to changes in the way the 

profiles are indexed. The Epson 9600, 7600, 4000 and 2200 (and older) printers do not work 
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with the Profile Valet. For those printers, the Custom Profile Setup tab can be used instead, and 

new profiles can be downloaded via an ftp-client software (please contact ImagePrint support at 

imageprint_support@colorbytesoftware.com in such case).  

2. If you are on a supported printer and the Profile Valet shows no profiles, the profile index files 

may be corrupt. Exit ImagePrint, delete the indexes and relaunch ImagePrint as follows: Click 

your Windows START menu and choose the ColorByte Software program group. In the ColorByte 

Software program group, choose “Data Folder”. In the folder window that appears, find the 

folder called “pindices” Delete the entire pindices folder. Relaunch ImagePrint and try the 

Profile Valet again.  

3. Check in ImagePrint’s PREFERENCES window (accessed via the VIEW menu within ImagePrint) 

that, in the General Section, “Set Profile Valet Offline” is NOT checked.  

4. If none of the above solutions help, it is very likely that ImagePrint’s access to our Profile site 

is being blocked. The Profile Valet uses FTP (not HTTP (web)) protocol, which some routers, 

security software or firewalls may restrict or block. Check your router/firewall settings for any 

restrictions on “Passive FTP” protocol. Disable or uninstall security software temporarily. If using 

a VPN (virtual private network) you may also experience problems accessing the Profile FTP site. 

As a test, you can try accessing the site via an FTP program like FileZilla ftp-client. The ftp host 

address is:  

ftp.colorbytesoftware.com  

and both the username and password are: profiles  

If that also fails to connect (or the connection is intermittent) then it is probable that ftp 

communication is being blocked on your computer or network. (Note that connecting to the site 

may be possible, but some routers/firewalls severely slow down downloading files or make the 

connection erratic and prone to closing.) If you can’t open access via your router or firewall, a 

workaround to a network that blocks access to our site might be to temporarily tether or “hot 

spot” your computer’s WiFi to your phone to use the phone’s internet connection, thus avoiding 

your local network, when downloading profiles. 

The Image Browser doesn’t work correctly  

1. If the Image Browser appears, but shows no files or folders, check that you have chosen a 

folder that actually contains supported image files. Click on the Folder Selector icon at the top 

of the Image Browser window to navigate to a folder with supported image formats (jpg, tiff, 

psd, pdf, png). Remember--the Image Browser, while convenient, is not the only way to open 

files. You can also drag files directly from their Windows folder into the ImagePrint layout area, 

mailto:imageprint_support@colorbytesoftware.com
ftp://ftp.colorbytesoftware.com/


Page 17 of 45 
 

or use the standard File -> Open menu dialog. Also, in most cases, Adobe Bridge can be used 

with ImagePrint.  

2. If you don’t see the Image Browser window at all, go to the View menu within ImagePrint and 

click on Add Image Browser. If that still doesn’t make it appear, try choosing “Reset Window 

Positions” from the VIEW menu to return the Image Browser (and other ImagePrint windows) to 

its default location. 

Deleting the ImagePrint Registry Settings  

ImagePrint maintains many of its settings in the Windows Registry. If these settings become 

corrupt, problems may result, including issues with the Image Browser, or settings windows that 

no longer appear on screen. In these cases, deleting the ImagePrint registry entry may solve the 

problem. The registry entry will be rebuilt the next time ImagePrint is launched with default 

settings in place. NOTE: Any custom page sizes you have created will be lost as a result of 

deleting the ImagePrint Registry settings and will need to be recreated via the User Defined 

page size window within ImagePrint. Also, your current Color Management selections will be 

returned to their default state, so you will need to re-select your profiles and settings within the 

Dashboard window after deleting the registry entry. (You may want to record those Dashboard 

settings before proceeding so you can easily re-select them afterwards).  

IMPORTANT: Make sure to close ImagePrint and Spoolface before removing the Registry entry. 

The Windows registry contains vital Windows system settings. Failure to follow these 

instructions carefully could result in problems with your Operating System.  

• Launch the Windows Regedit utility: Type regedit in the Windows Search field, and double-

click Regedit.exe when it appears in the results listing.  

• When the Regedit window appears double-click the HKEY_CURRENT_USER folder in the list of 

folders appearing on the left side to expand the list. Double click the Software folder icon, then 

the ColorByte Software folder icon.  

• Right-click the ImagePrint 13.0 folder icon and choose DELETE. That will delete our registry 

entry (it will be rebuilt when ImagePrint restarts).  

• Start ImagePrint again and check if the problem is resolved. 
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Printing Problems - ImagePrint BLACK 
Problems and questions related to printing and printing errors with ImagePrint BLACK are listed 

in this section. 

The Nothing Prints! Checklist 

Note: Many of these items require you to have launched SpoolFace (the ImagePrint print 

spooler) by choosing it from ImagePrint FILE menu or via the printer icon in the top right of the 

ImagePrint Dashboard. SpoolFace shows the status of your printing and any error messages that 

occur.  

• No Dongle or No License? DEMO printing occurs when ImagePrint is running in “DEMO” 

mode due to the USB dongle not being detected, a proper printer license not being in place or 

due to critical issues with a previous print that failed. You will either get no output from the 

printer if a license issue is detected and you are set to “Do not print in Demo” mode in 

SpoolFace under the Queue menu, or, if “Do Print in Demo” is selected in the menu you will get 

a DEMO watermark on your output. Check the status area on the right side of the SpoolFace 

window to see if an encryption/licensing issue is reported. Usually License and Dongle related 

messages are reported in RED. The most recent messages will be listed lowest in the status area. 

If you see license or dongle related errors, see the earlier section of this document (Licensing 

Issues) for trouble-shooting tips.  

• What’s the code? If there is an error when SpoolFace processes the print job, a status with 

a numeric code will appear in the VERY bottom left corner of the SpoolFace window. It will be in 

the form: Job ## Finished with error ###. This code can be very helpful in determining the cause 

of the problem. A list of the most common numeric error codes that may appear in SpoolFace 

appears later in this guide: SpoolFace Error Codes. If you do not see that status area, the bottom 

of the screen may be blocking it--try dragging the SpoolFace window up a bit. There will ALWAYS 

be some status shown in the bottom left corner of the SpoolFace window, even if just “Printer 

Idle”, so if you don’t see the status area keep looking--it’s there.  

• Paused? Click the Queue menu at the top of the SpoolFace window and make sure that 

printing is not paused. The spooler will pause all jobs if it encounters an error (such as running 

out of ink or paper) and it is important that you un-pause the spooler after correcting the 

problem or nothing new will be sent to the printer. If the queue is paused there will be a check 

mark next to the word PAUSE under the Queue menu at the top of the SpoolFace window, and 

the status message in the bottom left corner of SpoolFace will say “Paused” along with the last 

error code (if any). Un-pause the queue by simply selecting the PAUSE entry under the QUEUE 

menu (Be careful! Once you un-pause the queue, any jobs at the top of SpoolFace will be in line 
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to print--clear out any jobs you don’t want from the top by dragging them down to the Saved 

Jobs part of SpoolFace).  

• Old Job(s) in the way? The top job in the top (active) section of SpoolFace is only job 

currently attempting to print. If that top job had or has a problem no other jobs under it will be 

able to print until that job is cancelled (usually by dragging it down to the Saved Jobs section of 

SpoolFace).  

• Wrong setting in ImagePrint? Sometimes printing problems are the result of an incorrect 

setting within ImagePrint. Actually--not many wrong settings can stop printing cold, but NOT 

having applied a profile for your media can. So--make very sure you have chosen and APPLIED a 

Printer profile for your media in the Media Management section of the Dashboard. The 

currently applied printer profile will always show in Blue beside the word Media Management in 

the Dashboard--if you don’t see your profile in blue there it is not applied. With no paper profile 

applied printing will fail, often with an error 163 in SpoolFace.  

• Nothing appears in SpoolFace? If nothing prints AND you’re getting no job added to the 

top (Active) part of SpoolFace when you click PRINT in ImagePrint, check the following section: 

Nothing appears in SpoolFace (and nothing prints!)  

• Print to File? Make sure the Print to File option is not selected in ImagePrint Preferences – 

select View->Preferences to see the status of this option on the first tab there. With Print to File 

enabled, no printing will take place--instead a TIFF file containing the layout will be created.  

• Printer or connection issue.  Check if the printer prints when a print is sent from other 

program using system printer driver. If this fails, follow the troubleshooting suggestions from 

the printer manufacturer.  

• Error on the Printer? If prints are failing and you’re getting an error on the printer, see the 

entry later in this section Common Printer Error Messages.  

• Nothing Obvious? Contact ImagePrint support at 

imageprint_support@colorbytesoftware.com (follow the format described in the section 

Emailing Colorbyte Support above). 

 

Nothing appears in SpoolFace (and nothing prints!)  

1.) Are you sure that nothing appears in SpoolFace? Sometimes it may seem like no job went 

into SpoolFace, but in fact it just moved to the Saved (bottom) very quickly. If the job is actually 

hitting the top (active) side and then moving to the bottom quickly, there may be some error 

mailto:imageprint_support@colorbytesoftware.com
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status (like a Licensing/ Dongle issue) on the right side of SpoolFace that sheds light on what’s 

happening. 

2.) Wrong Printer? If you have multiple ImagePrint printers installed, make sure you have the 

right one selected under the PRINTERS menu in SpoolFace. Only jobs from the selected printer 

will show.  

3.) Anti-virus software? It’s not uncommon for anti-virus software to block, delete or 

quarantine parts of ImagePrint. Even if you’ve had no problem, an update can cause an anti-

virus program to suddenly mis identify an ImagePrint component as suspicious and block, 

quarantine or even delete it. Try disabling any anti-virus software as a test--Note: because 

disabling often leaves anti-virus components still running, you may need to uninstall the anti-

virus software as a test to ensure it is still not blocking the printing processes.  

Repair the Damage: If you suspect your anti-virus has deleted or quarantined some component 

of ImagePrint, you can try a repair (After disabling the anti-virus software!) via the Apps control 

panel on your Windows system. Click ImagePrint Black/RED in the list of installed Apps and 

choose REPAIR when given the option. That will put back many ImagePrint components and 

may fix the problem.  

Make an Exclusion: Most Anti-virus software programs let you designate folders and programs 

to be excluded from virus scanning. If yours does, you should tell the anti-virus software not to 

scan these folders and their sub-folders to prevent future problems: \ program files \ ImagePrint 

and \ ProgramData \ ColorByte Software \ ImagePrint 64bit 

 

Common Printer Error Messages  

The below messages may appear on the front panel of your printer when a print job fails  

“Load ROLL” (or Sheet) Paper -- This message appearing on the printer means that ImagePrint 

Black is set to a paper type (sheet or roll) that is not currently loaded in the printer. Make sure 

the matching setting, “sheet” or “roll”, is selected in the ImagePrint Dashboard in the Printer 

Selector section. Once you have set the sheet/roll trigger correctly, cancel any old failed jobs in 

SpoolFace by dragging them down to the SAVED section, un-pause the QUEUE via the QUEUE 

menu at the top of the SpoolFace window and make sure the printer is back to a Ready before 

trying a new print. In addition to the above, for some printers you will need to make sure the 

printer’s control panel (on the front of the printer) is set to the right mode for the currently 

loaded paper type. (Often, pressing the Roll/Sheet button on the printer when this error occurs 

will let the job continue).  
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“Reload Paper”/”Paper Out” -- “Reload Paper” messages often mean the paper loaded in the 

printer is NARROWER than the page size specified in ImagePrint, or a sheet of paper is loaded in 

a paper feeder that does not match the one selected in ImagePrint. Make sure the page size 

and/or tray in the Printer Selector in the Dashboard window matches size of paper loaded on 

the printer and the paper feeder used. “Paper Out” messages, or the paper feeding through the 

printer without printing, typically occurs if the paper in the printer is SHORTER than the page 

size specified in ImagePrint, if the paper is too small for the selected tray. To correct, specify a 

page size in ImagePrint that is the same as the physical paper’s length or shorter. (Double check 

by measuring the actual paper--some manufacturers can be slightly inaccurate in the 

dimensions specified on the box). Check the printer’s manual to make sure the paper is not too 

small for the selected tray, reload paper into the tray that supports this size and select the 

matching tray in ImagePrint. Another cause of paper feeding right through the printer without 

printing is a paper sensor issue. Make sure to use a clean sheet of paper, as the printer’s sensors 

check for paper white and can be fooled by previously printed images on a page. 

 

Common Errors when launching SpoolFace  

Check the below suggestions when SpoolFace fails to launch or generates an error when 

launched  

SpoolFace generates an “Error CONNECT 10061” type error   

If you get an error with “Connect” in the error text, a critical background process (MUXD 64bit) 

is probably not running. During ImagePrint’s installation, MUXD 64bit is set to automatically 

launch each times Windows starts (Muxd_64bit is added into Window Settings -> Apps -> Staup 

Apps), but Anti-virus programs sometimes prevent the automatic launch from happening or 

even delete the muxd_64bit.exe file entirely. It is beyond the scope of this manual to provide 

support for the myriad anti-virus products available, but check your anti-virus logs to see if 

there’s a report of muxd_64bit.exe being blocked. The Windows Firewall can also block 

muxd_64bit.exe, so check its settings as well. You may need to set an “exclusion” for the 

\program files\ImagePrint folder within your antivirus software settings to prevent the software 

from interfering with ImagePrint. Note: Even if your anti-virus software has worked with 

ImagePrint in the past, it doesn’t mean it can’t change with no warning. Antivirus software 

often updates their virus definitions which can cause it to suddenly mis identify muxd_64bit.exe 

(or another ImagePrint component) as suspicious. You can manually launch muxd_64bit.exe 

from its location within the ImagePrint/spool/mux folder. Just go to c: \ program files \ 

ImagePrint \ Spool \ Mux and double-click muxd_64bit.exe. A brief window will flash as the 
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process is put into the background, but nothing else will seem to happen. At that point, 

Spoolface should work... at least until you reboot windows. 

“No Printers Found” error when launching SpoolFace  

You may see a “No Printers found” message if you are on an ImagePrint CLIENT computer and 

are launching SpoolFace for the first time. This is normal behavior as SpoolFace defaults to look 

for a printer on the local computer instead of a networked HOST computer. To correct the 

problem, just choose COMPUTER (from the SpoolFace menu), and pick the IP Address (or 

computer name) of the ImagePrint HOST computer. If there is no PRINTER or COMPUTER menu 

at the top of the screen when SpoolFace is active, there is a problem with the installation. Close 

SpoolFace and ImagePrint, then re-launch IPSetup (from the ImagePrint folder), remove and 

reinstall the printer(s) using the corresponding buttons in the window.  

“Cannot connect to [ip-address of the host computer]” message in SpoolFace  

This error occurs when printing from an ImagePrint CLIENT to an ImagePrint HOST computer if 

the two computers cannot see each other via the TCP/IP network protocol. Firewalls or anti-

virus software may prevent the Client from communicating with the Host. You should also check 

via the Windows Task Manager that the “muxd_64bit.exe” process is running on both the Host 

or Client (muxd_64bit is necessary for client/host printing to take place). If ip-address or the 

computer name of the host has changed since a remote printer was added in IPSetup on the 

client, then SpoolFace on the client will not be able to communicate with the host. Make sure 

that ImagePrint and Spoolface are not running on the client, launch IPSetup, remove the printer 

and add it back entering the current ip-address of the host or selecting the current computer 

name of the host. 

Extra print jobs sent to SpoolFace  

This is the result of additional pages existing in the ImagePrint layout window. This can happen 

if AutoFlow is enabled and you have added images to your layout without first deleting previous 

images via the scissors tool--new pages are generated for new images when there is no room on 

the current page. By default, ALL images on ALL pages will print when PRINT is selected. 

Autoflow can be turned on and off via the AutoFlow checkbox in the Dashboard’s Layout 

Settings section. To delete ALL images from all pages, click the Red scissors icon in the Tools bar. 

Couldn’t Set Up Watch folder error message in SpoolFace  

If printing from a networked CLIENT computer, this message typically means the PRINTER NAME 

used when installing ImagePrint on the CLIENT doesn’t exactly match the PRINTER NAME used 

when installing on the host. Launch IP Setup from your ImagePrint folder on the CLIENT and 

make sure the installed printer matches that shown on the HOST. If not, remove and reinstall 
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the printer on the client with the correct name. Also, confirm the same version of ImagePrint is 

installed on both the client and the host computers. If you are NOT on a remote Client and you 

see the “Couldn’t Set Up Watch” error, that typically means your printer spool folder structure is 

corrupt; possibly due to a failed printer installation that couldn’t write files to your hard drive 

because it did not have permissions, or pre-existing files it needed to overwrite were busy when 

IP Setup was run. Usually, removing and reinstalling the printer via IPSETUP will correct this 

problem (you will lose your old spooled jobs however when removing the printer). Make sure 

ImagePrint and SpoolFace were closed before using IPSetup to remove and then add the printer. 

Problems when printing from a networked client  

A Client installation of ImagePrint will run the normal ImagePrint interface, but, when Print is 

selected, will send all of its jobs to the ImagePrint HOST computer (the Host is always the 

computer with the DONGLE attached). When installing a client, remember that the Client does 

not need to be licensed in IPSetup. All licensing is handled by the HOST at print time, so only the 

HOST computer needs to be licensed.  

Below are things to check if you experiencing problems printing from a client to a host:  

1.Make sure that the Host computer can print directly to the printer first to rule out a problem 

with printing in general.  

2.Make sure that the Client computer can access the Host across the network via normal 

Windows networking.  

3.Firewall settings, on either the Host or Client, can block ImagePrint from sending jobs. Try 

printing from the Client with the Firewall disabled on both systems. Also, security software or 

anti-virus software, may be blocking the TCP/IP port that ImagePrint uses for network 

communication. (ImagePrint uses port 1 for its client/host printing).  

4.If the Host can print fine locally, but jobs from the Client do not appear in the Host’s SpoolFace 

window, make sure that you correctly specified the name of the Host computer (or the IP 

Address if the Host is a Macintosh) when installing ImagePrint on the Client. To double-check, 

launch IPSetup and see what setting is listed in the HOST column for the printer. If it does not 

show the proper computer (or its IP Address), delete the printer using the DELETE PRINTER 

button in IPSetup and then re-add the printer by clicking ADD PRINTER and following the 

prompts to add a new client (remote) printer. Make very sure to pick “Remote Client” as the 

install type in the Printer Parameters window and use the same printer name as used on the 

HOST computer. Also, make sure to use the correct IP Address or name for the HOST computer 

when prompted to Specify the Host Computer. (The HOST computer is the computer with the 

USB dongle attached).  
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5.Couldn’t set up Watch Folder: If you receive this error in SpoolFace it’s likely the PRINTER 

NAME you specified when installing ImagePrint on the CLIENT does not exactly match the name 

you used on the HOST. Re-add the printer via IPSetup making sure to use the exact same printer 

name used on the host computer. Also confirm the same version of ImagePrint is installed on 

both the client and the host computers. 

6.The process “muxd_64bit” must be running on each Windows computer (host or client) in 

order for communication to take place. You can confirm that this process is running via the 

Windows Task Manager (hit Control-Alt-Delete to access it). If muxd_64bit is NOT listed under 

“PROCESSES” follow the procedures earlier in this guide to correct the problem: Spoolface 

reports a “CONNECT” error. 

Job doesn’t move to the bottom (SAVED) side of SpoolFace when dragged down  

Normally, dragging a job from the top (“Active”) pane to the bottom (“Saved”) pane should 

cancel it. If the job will not move down (it pops back up), it means that the printing process is 

not being allowed to quit normally by Windows. To force the job over, PAUSE the queue by 

choosing Queue->Pause from the SpoolFace menu and then reboot the computer. The job 

should drag down with no problem when the system comes back up. (It is important to pause 

the queue first to make sure the spooler doesn’t attempt to print again as soon as the system 

reboots.) After rebooting and moving the job down, remember to re-enable the queue by 

choosing “Pause” from the same menu to get rid of the check mark beside the Pause entry. If 

you don’t want to reboot the computer, you can use the Windows Task Manager to kill the 

printing process. Access the Windows task manager by pressing Control Alt-Delete. Click TASK 

MANAGER, then PROCESSES. Choose either the printer driver executable (i.e. epsonP7000.exe) 

or the process “ipbatch_64bit.exe” and click the “End Process” button. The job will immediately 

move over in SpoolFace. It’s a good idea to reboot the printer after doing this, since it may have 

gotten some partial print data in its memory that should be cleared. 

Old computer names or ip-addresses appear in my SpoolFace Computers menu on the client 

This can happen if you’ve installed ImagePrint as a Client to a HOST computer that’s no longer 

available on your network. Reinstalling the printer to point to the new HOST computer may 

leave the old computer entries in the COMPUTERS menu, which can be an annoyance. To 

remove any old computer names from the SpoolFace COMPUTERS menu, close SpoolFace and 

locate the file “ip hosts” located in the Spool folder within the ImagePrint “data” folder (To get 

to the ImagePrint DATA folder, choose “Data Folder” from the ColorByte Software Program 

Group in your Windows Start Menu.) Edit the “ip_hosts” file using a standard text editor such as 

Notepad, delete any lines containing unwanted computer names or ip-addresses and resave the 
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file, then relaunch SpoolFace. (Make sure to leave no empty lines in the file including at the very 

bottom).  
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Printing Problems - ImagePrint R.E.D.  
Problems and questions related to printing and printing errors with ImagePrint R.E.D. are listed 

in this section  

The Nothing Prints! Checklist 

 There could be many reasons for your jobs not to make it to the printer. Here are the things to 

check when you are unsure of the problem. Carefully stepping through this list should solve the 

vast majority of printing issues with ImagePrint R.E.D.  

Note: Many of these items require you to have launched SpoolFace (the ImagePrint print 

spooler) by choosing it from ImagePrint FILE menu or via the printer icon in the top right of the 

ImagePrint Dashboard. SpoolFace shows the status of your printing and any error messages that 

occur.  

• No Dongle or No License? DEMO printing occurs when ImagePrint is running in “DEMO” 

mode due to the USB dongle not being detected or a proper printer license not being in place. 

You will either get no output from the printer if a license issue is detected and you are set to 

“Do not print if Demo” mode in SpoolFace under the Queue menu, or, if “Do Print if Demo” is 

selected in the menu you will get a DEMO watermark on your output. Check the status area on 

the right side of the SpoolFace window to see if an encryption/licensing issue is reported. 

Usually License and Dongle related messages are reported in RED. The most recent messages 

will be listed lowest in the status area. If you see license or dongle related errors, see the earlier 

section of this document (Licensing Issues) for trouble-shooting tips.  

• What’s the code? If there is an error when SpoolFace processes the print job, a status with a 

numeric code will appear in the VERY bottom left corner of the SpoolFace window. It will be in 

the form: Job ## Finished with error ###. This code can be very helpful in determining the cause 

of the problem. A list of the most common numeric error codes that may appear in SpoolFace 

appears later in this guide: SpoolFace Error Codes. If you do not see that status area, the bottom 

of the screen may be blocking it--try dragging the SpoolFace window up a bit. There will ALWAYS 

be some status shown in the bottom left corner of the SpoolFace window, even if just “Printer 

Idle”, so if you don’t see the status area keep looking--it’s there.  

• Paused? Click the Queue menu at the top of the SpoolFace window and make sure that 

printing is not paused. The spooler will pause all jobs if it encounters an error (such as running 

out of ink or paper) and it is important that you un-pause the spooler after correcting the 

problem or nothing new will be sent to the printer. If the queue is paused there will be a check 

mark next to the word PAUSE under the Queue menu at the top of the SpoolFace window, and 

the status message in the bottom left corner of SpoolFace will say “Paused” along with the last 



Page 27 of 45 
 

error code (if any). Un-pause the queue by simply selecting the PAUSE entry under the QUEUE 

menu (Be careful! Once you un-pause the queue, any jobs at the top of SpoolFace will be in line 

to print--clear out any jobs you don’t want from the top by dragging them down to the SAVED 

part of SpoolFace).  

• Old Job(s) in the way? The top job in the top (active) section of SpoolFace is only job currently 

attempting to print. If that top job had or has a problem no other jobs under it will be able to 

print until that job is cancelled (usually by dragging it down to the SAVED side of SpoolFace).  

• Nothing appears in SpoolFace? If nothing prints AND you’re getting no job added to the top 

(Active) part of SpoolFace when you click PRINT in ImagePrint, check the following section: 

Nothing appears in SpoolFace (and nothing prints!)  

• Print to File? Make sure the Print to File option is not selected in ImagePrint Preferences. With 

Print to File enabled, no printing will take place--instead a TIFF file containing the layout will be 

created.  

• Error on the Printer? If prints are failing and you’re getting an error on the printer, see the 

entry later in this section Common Printer Error Messages.  

• Permissions Problem? A Permissions problem can be a little hard to diagnose. Generally, 

printing fails with no error, or possibly you’ll see some License related errors in SpoolFace even 

though IPSetup shows your printer as licensed. This problem can seem to happen out of the 

blue, though usually it’s after a Windows update. Try removing and reinstalling printer in 

IPSetup while ImagePrint and SpoolFace are closed. If this does not help, uninstall ImagePrint 

using Windows Settings -> Apps and then reinstall. If using ImagePrint on a system with several 

user accounts, make sure all users have full read/write access to all folders inside 

C:\ProgramData\Colorbyte Software. 

System Printer Driver Problems: The final common printing issue involves problems with the 

Windows Printer Driver for your printer. ImagePrint R.E.D. utilizes the driver supplied by your 

printer manufacturer to communicate with the printer, and many settings--such as Page Size, 

Borderless behavior and Media Type are taken from their driver. Any incorrect setting there--or 

any problem with the System Printer Driver itself--can cause your prints to fail. Check the 

following section for suggestions on correcting issues due to the Windows System Driver: 

Windows System Driver - Connectivity and Settings Issues. 

Windows System Driver - Connectivity and Settings Issues  

• Check the System Driver Settings In ImagePrint R.E.D., click the Setup... button in the Printers 

section of Dashboard to access your printer’s Windows Driver. It’s vital that you have correctly 

set the key elements: page size, media type and color management (ICM) mode for your printer 
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before printing. (In addition, settings like borderless mode, auto-cut mode should be correctly 

configured although they are less likely to cause a print to fail.)  

• Check the System Driver Queue If jobs have failed to print with no obvious error, they may be 

“stuck” in the system printer’s spooler. Go to your Windows Devices and Printers control panel 

and double-click the driver for your printer to access its job queue. If there are jobs listed, try 

deleting them then try printing again. (Note that any errors listed in this window may indicate a 

printer issue that needs to be corrected according to the printer manufacturer’s instructions.)  

• Try printing from another application Try printing to the printer from another application to 

be sure there’s no problem with the system printer driver. If other applications can’t print as 

well, you may need to reinstall the printer driver according to your printer manufacturer’s 

instructions (typically you would remove the driver from the Windows Devices and Printers 

control panel, then go to the printer maker’s web site, download the driver and reinstall it). 

After reinstalling the printer driver, make sure to reselect it in ImagePrint R.E.D. and check its 

settings by clicking the Setup... button in that section.  

• Reinstall the Driver When all else fails, try removing and reinstalling the system printer driver. 

First, remove the driver from the Devices and Printers control panel. Then, download the driver 

again from your printer maker’s website and install it. After reinstalling the printer driver, make 

sure to reselect it in ImagePrint R.E.D. and check its settings by clicking the Setup... button in 

that section. 

 

Nothing appears in SpoolFace (and nothing prints!)  

1.) Are you sure that nothing appears in SpoolFace? Sometimes it may seem like no job went 

into SpoolFace, but in fact it just moved to the Saved (bottom) very quickly. If the job is actually 

hitting the top (active) side and then moving to the bottom quickly, there may be some error 

status (like a Licensing/Dongle issue) on the right side of SpoolFace that sheds light on what’s 

happening. If there’s definitely no errors there and the job is moving down without printing, 

check the Fixing Printer and Driver Communication Problems entry earlier in this document.  

2.) Wrong Printer? If you have multiple ImagePrint printers installed, make sure you have the 

right one selected under the PRINTERS menu in Spoolface. Only jobs from the selected printer 

will show.  

3.) OS Update? ImagePrint libraries may have been overwritten in a recent Operating System 

update. To fix that, try checking for updates from ImagePrint’s Help menu. If your ImagePrint is 

already up-to-date, try using the Repair option in Windows Settings -> Apps.  
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4.) Anti-virus software? It’s not uncommon for anti-virus software to block, delete or 

quarantine parts of ImagePrint. Even if you’ve had no problem, an update can cause an anti-

virus program to suddenly misidentify an ImagePrint component as suspicious and block, 

quarantine or even delete it.  

Try disabling any anti-virus software as a test--Note: because disabling often leaves anti-virus 

components still running, you may need to uninstall the anti-virus software as a test to ensure it 

is still not blocking the printing processes.  

Repair the Damage: If you suspect your anti-virus has deleted or quarantined some component 

of ImagePrint, you can try a repair (After disabling the anti-virus software!) via the Apps control 

panel in your Windows Settings. That will put back many ImagePrint components and may fix 

the problem.  

Make an Exclusion: Most Anti-virus software programs let you designate folders and programs 

to be excluded from virus scanning. If yours does, you should tell the anti-virus software not to 

scan these folders and their sub-folders to prevent future problems: \ program files \ ImagePrint 

and \ programdata \ ColorByte Software \ ImagePrint 64bit 

Common Printer Error Messages  

The below messages may appear on the front panel of your printer when a print job fails  

“Load ROLL” (or Sheet) Paper -- This message appearing on the printer means that ImagePrint 

RED is set to a paper type (sheet or roll) that is not currently loaded in the printer. Make sure 

you have selected the right type in the Windows Printer Driver – click on the “Setup…” button in 

the Printer Selector section in the Dashboard window to verify the printer driver settings. 

Before printing again, you should check the Windows Printer Driver’s queue (in Windows 

Devices and Printers) and clear any failed jobs from it along with any error messages the driver 

may show. In addition to the above, for some printers you will need to make sure the printer’s 

control panel (on the front of the printer) is set to the right mode for the currently loaded paper 

type. (Often, pressing the Roll/ Sheet button on the printer when this error occurs will let the 

job continue).  

“Reload Paper”/”Paper Out” -- “Reload Paper” messages often mean the paper loaded in the 

printer is NARROWER than the page size specified in Windows printer driver in ImagePrint RED, 

or a sheet of paper is loaded in a paper feeder that does not match the one selected in that 

driver. Click on the “Setup…” button in the Printer Selector section in the Dashboard window to 

verify the printer driver settings. To correct, specify a page size in the driver that is the same as 

the physical paper’s width and length. (Double check by measuring the actual paper--some 

manufacturers can be slightly inaccurate in the dimensions specified on the box). Check the 
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printer’s manual to make sure the paper is not too small for the selected tray, reload paper into 

the tray that supports this size and select the matching tray in the printer driver. Another cause 

of paper feeding right through the printer without printing is a paper sensor issue. Make sure to 

use a clean sheet of paper, as the printer’s sensors check for paper white and can be fooled by 

previously printed images on a page. 

Common Errors when launching SpoolFace  

Check the below suggestions when SpoolFace fails to launch or generates an error when 

launched  

SpoolFace generates an “Error CONNECT 10061” type error   

If you get an error with “Connect” in the error text, a critical background process (MUXD 64bit) 

is probably not running. During ImagePrint’s installation, MUXD 64bit is set to automatically 

launch each times Windows starts (Muxd_64bit is added into Window Settings -> Apps -> Staup 

Apps), but Anti-virus programs sometimes prevent the automatic launch from happening or 

even delete the muxd_64bit.exe file entirely. It is beyond the scope of this manual to provide 

support for the myriad anti-virus products available, but check your anti-virus logs to see if 

there’s a report of muxd_64bit.exe being blocked. The Windows Firewall can also block 

muxd_64bit.exe, so check its settings as well. You may need to set an “exclusion” for the 

\program files\ImagePrint folder within your antivirus software settings to prevent the software 

from interfering with ImagePrint. Note: Even if your anti-virus software has worked with 

ImagePrint in the past, it doesn’t mean it can’t change with no warning. Antivirus software 

often updates their virus definitions which can cause it to suddenly mis identify muxd_64bit.exe 

(or another ImagePrint component) as suspicious. You can manually launch muxd_64bit.exe 

from its location within the ImagePrint/spool/mux folder. Just go to c: \ program files \ 

ImagePrint \ Spool \ Mux and double-click muxd_64bit.exe. A brief window will flash as the 

process is put into the background, but nothing else will seem to happen. At that point, 

Spoolface should work... at least until you reboot windows. 

Extra print jobs sent to SpoolFace  

This is the result of additional pages existing in the ImagePrint layout window. This can happen 

if AutoFlow is enabled and you have added images to your layout without first deleting previous 

images via the scissors tool--new pages are generated for new images when there is no room on 

the current page. By default, ALL images on ALL pages will print when PRINT is selected. 

Autoflow can be turned on and off via the AutoFlow checkbox in the Dashboard’s Layout 

Settings section. To delete ALL images from all pages, click the Red scissors icon in the Tools bar. 
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SpoolFace error codes  
When there is a problem printing, SpoolFace usually reports a text or numeric error code that 

can be referenced in this section.  

Where is the error code?  

The bottom left corner of SpoolFace shows the current spooler status or the error code of the 

most recent failed job. (If you don’t see this status area, move the SpoolFace window up a bit so 

it’s not blocked by the bottom of the screen. A status message will ALWAYS be in the very 

bottom left corner of the window, even if it’s not reporting an error.) Also--be sure to check the 

right (Log) side of SpoolFace for information regarding printing errors, going from the bottom 

up. Look for anything in RED, and any messages that clearly state that a licensing/dongle error 

has occurred.  

ERROR 1 can occur if an illegal character (such as a space) was used in the PRINTER NAME 

when installing via IPSetup, or if anti-virus software is running on your computer that is 

interfering with ImagePrint’s printing processes. If you do have anti-virus software, try disabling 

it and see if the problem persists. If there are spaces or non-alphanumeric characters in a 

printer name you used when installing via IPSetup, remove and reinstall the printer in IPSetup. If 

removing and reinstalling the driver via IPSetup fails to solve the problem, try removing 

ImagePrint completely via Windows Settings -> Apps and reinstalling using the current installer 

downloaded from www.colorbytesoftware.com. 

ERROR 2 or ERROR 15 (ImagePrint BLACK only) This indicates a problem 

communicating with the printer. Make sure the printer is on and online (go to Windows Settings 

-> Devices -> Printers&Scanners to verify the status). Make sure that you specified the correct 

connection setting when installing ImagePrint (you can double-check this by launching IPSetup 

and seeing what is listed in the Connection column for your printer. The device selection will 

show up under the connection column--it will either be the port the printer is connected to (i.e. 

USB001) or the name of the Windows Printer driver you chose when installing (ImagePrint will 

use whatever port that driver is using when installed in this way) or the IP ADDRESS of the 

printer (if connected via Ethernet or WIFI to the printer). If in doubt, try removing, then 

reinstalling while ImagePrint and SpoolFace programs are closed. If you’re sure the connection 

was specified correctly and you still get the error, you may have a device driver problem. Try 

printing from the printer manufacturer’s driver via the Test Page option within the Printers and 

Scanners driver for that printer. If that also fails, switch connection cables to ensure there is no 

problem there, and make sure to reboot both the printer, and the computer to reset both 

interfaces. 

http://www.colorbytesoftware.com/
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ERROR 97 This is usually a file access problem—the spooler is not able to access the file to be 

printed. Make sure the file(s) to be printed is still accessible. Deleting a file or moving it from its 

folder after clicking PRINT in ImagePrint before the image has actually printed can cause this 

condition as the Spooler will not be able to access the file. Having your files on a thumb drive, 

and ejecting the thumb drive before the printing takes place, will cause this as well. All the 

images on the page must remain in their original location while the page is printing. If your 

images are located across a network, try moving it to a local directory and reprinting to confirm 

a network access issue is not the cause. 

ERROR 163 can be reported in a few different cases. Below are the most common ones:  

Paper Profile issue -- Make sure you have selected a paper profile via the Profile Valet in the 

Dashboard window in Image Print and applied it. If the paper profile was selected on the Profile 

Valet but was not applied (by clicking the Apply (or Download and Apply) button), the printer 

driver will be missing critical print parameters and a job will fail.  

Profile Valet index not available -- Each time ImagePrint is launched, the Profile Valet connects 

to ColorByte’s online profile site via FTP (File Transport Protocol) and downloads “index” files 

containing settings to use with each available paper profile. Without these index files, you may 

get error 163 when attempting to print. Double-check that the profile valet is working correctly 

in the dashboard (if you see profiles listed, it’s working). 

Printer is offline – make sure the printer is on and the connection cable is connected, go to 

Windows Settings -> Devices -> Printers&Scanners to verify the status of the printer and follow 

printer’s troubleshooting guide if the printer appears offline in that window. 

Communication issue - Make sure that you specified the correct connection setting when 

installing ImagePrint and it still matches the current configuration (you can double-check this by 

launching IPSetup, seeing what is listed in the Connection column for your printer and 

comparing to the system printer driver name in Windows Settings, USB port number, if it’s an 

older printer, or current ip-address of the networked printer). See the suggestions for errors 2 

and 15 provided above. 

Problems specific to the Epson SureColor 

P700/900/5000/5300/6000/7000/7500/8000/9000/9500/10000/20000 and Canon printers  

Wrong driver selected in IPSetup -- For these newer printers, you must have the manufacturer’s 

system printer driver installed in order for ImagePrint to “find” the printer. This is done during 

printer setup via ImagePrint’s IPSetup utility. If an incorrect choice was made (for example, if 

using P7000CE with Violet ink and in IPSetup you chose the driver for the standard SureColor 

P7000) you may see an error 163 when attempting to print.  
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Malfunctioning manufacturer’s driver -- As mentioned, for the above listed printers, the 

Epson/Canon native printer driver should be installed on the computer. You should also confirm 

that the driver is able to produce a test print. If the printer is unable to produce a test print, you 

may need to redownload it from Epson or Canon and reinstall it. Then remove/re-add the 

printer in IPSetup to re-establish ImagePrint’s connection.  

Printer Sleep issue -- If your Epson P##### printer was in energy saver mode when the very first 

print was sent from Image Print, the print request will wake up the printer, but the printer may 

fail to respond in time and error 163 may occur. Simply un-pause the QUEUE in the Spool Face 

and try printing again. (If you see issues sometimes when printing to a printer when it is asleep, 

wake up the printer by touching a button on the printer before clicking Print). 

ERROR code starting with 107… may occur if anti-virus software is running on your 

computer that is interfering with ImagePrint’s printing processes. If you do have anti-virus 

software, try disabling it and see if the problem persists, or tell the anti-virus software not to 

scan these folders and their sub-folders to prevent future problems: \ program files \ ImagePrint 

and \ ProgramData \ ColorByte Software \ ImagePrint 64bit.  

This error may be reported when printing POD images after Microsoft security update. If you 

use POD client, try printing our sample_portrait.tif located in ProgramData \ ColorByte Software 

\ ImagePrint 64bit \ TestImages folder. If ImagePrint is able to print sample_portrait.tif (even if 

in demo mode), but reports error 107… when trying to print POD images, exit ImagePrint and 

SpoolFace and try using Repair option in Windows Settings -> Apps for ImagePrint RED/Black. If 

the error is not resolved after the repair, uninstall and reinstall ImagePrint. 

This error may be reported when printing for the first time from version 13 after upgrading from 

version 11 or older, if an older file was locked up and could not be upgraded. Navigate to 

Windows Settings -> Apps, select ImagePrint RED/Black and click to Uninstall, then navigate to 

C:\Windows\SysWOW64, delete LibIccDll.dll, then download current ImagePrint installer from 

our web-site www.colorbytesoftware.com and install ImagePrint v13 fresh. 

This error may indicate an issue with a custom template if you designed a template in 

ImagePrint and tried to use it for the first time. Test if older templates work, and if they allow 

printing without an error, contact ImagePrint support for help troubleshooting your custom 

template. The support can be reached at imageprint_support@colorbytesoftware.com. 

If a print job includes image files with very long file name (over 50 characters or so), cancel the 

print, clear the layout in ImagePrint, shorten file names, open the renamed files in ImagePrint 

and send a new print. We also recommend to make sure your ImagePrint v13 is up-to-date – 

while not printing, close the SpoolFace and use Help->Check_for_updates menu in ImagePrint 

http://www.colorbytesoftware.com/
mailto:imageprint_support@colorbytesoftware.com
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to update. If using ImagePrint in client/host environment, make sure to update both the host 

and the client computers. 

If this error is reported when printing PSD files, make sure an image was flattened (use Layers-

>Flatten Image menu in Photoshop) and extra channels were removed before file is saved for 

printing. 

If this error is reported for some specific image mode try changing it, for example, when printing 

16-bit LAB image, convert to 16-bit RGB instead. 

Error 161 - This is usually a file access problem when files were opened from a mapped 

network storage — the spooler is not able to access the file to be printed due to changes in 

Microsoft security settings. Make sure the mapped drive resource is available for all user 

accounts, including the admin account, and all these accounts have a full access. Another 

solution is to navigate to files via “Network” section in the File Browser, instead of a mapped 

drive, to avoid this file access error.  
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Output Quality Issues 
Look in this section if you are able to print, but you have questions regarding the quality of the 

output. 

My output is darker than it appears on screen 

Remember---ImagePrint is always soft proofing, meaning it is passing its display through the 

printer profile. Your display in ImagePrint should look close to your print if you are using a 

calibrated monitor and your settings are correct. As a test, always look at the display in 

ImagePrint and compare it to the print--don’t just compare it to the display in Photoshop. 

If colors are correct, but the overall print seems dark compared to the ImagePrint or Photoshop 

display, it is most likely caused by your monitor being too bright. Calibrating your monitor may 

ensure color accuracy, but by default the calibration software will not attempt to match the 

relatively dark look of a print (which has no nearly pure whites or blacks like those of a monitor 

display). Also, the brightness of the room you are viewing the print in is a factor that is very hard 

to compensate for. Many modern monitors are factory calibrated to be very bright. Even if you 

have custom calibrated your monitor, it is very likely that it is brighter than the “standard” CRT 

monitor of the past. One solution is to calibrate the monitor to a low luminance value, if your 

calibration software allows for that. A simpler solution is to physically dialing down the 

brightness of the monitor, using it’s on screen controls. Make a print of an image, display the 

same image on the screen in ImagePrint, and then adjust the controls until the relative darkness 

of the image on the screen matches that of the print. Write down the monitor settings--you can 

use those whenever you are editing images for print, knowing that what you are seeing on 

screen is a relatively close match to the brightness of the print. 

 Another cause of images appearing too dark when printed--especially for matte media--is lack 

of soft proofing when displaying the image on screen in photo editing software, i.e. Photoshop 

or Lightroom. Softproofing simply means that the software you are using to view the image 

compensates for the Paper/Printer/Inks in generating its display. Typically, this is done via the 

Paper Profile you will be using to output the image. When softproofing, the viewing software 

passes the image through the paper profile to show you what the image will look like when 

printed. Typically, this means less bright whites, less dark blacks, and a reduced color gamut. If 

NOT soft proofing, the image is reproduced on your display without any compensation for how 

it will look when printed, and since you might be printing on anything from high gloss film to 

watercolor paper, that means the display may be a very inaccurate predictor of how your print 

will appear. Softproofing is important when editing your images for print so you can 

compensate for the limitations the printing process introduces. This is most true for matte 

papers which tend to reduce density and color gamut much more than photo papers. Make sure 
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to select printer/paper profile in Proof Setup feature in photo editing software when adjusting 

images. 

• Wrong side of the paper: Don’t be embarrassed by this one--it happens to us too. It’s 

sometimes very hard to tell which side of the paper to print on. Make sure you are printing on 

the coated side (as a test, touch a wet finger to each side of the paper--the stickier side is 

usually the coated (printable) one). 

Color cast in prints  

Nozzles: As with any color issue, make sure you have done a nozzle check on the printer, and 

that all nozzles are clean. Nozzle issues are the chief cause of color cast problems. For some 

printer’s it’s not uncommon for an entire ink channel can be blocked so make sure to count that 

all inks are represented in the nozzle check print.  

Incorrect ImagePrint Color Settings: Double-check your color management settings.  

Output Profile Settings ImagePrint Black: In the ImagePrint Dashboard, in the MEDIA 

MANAGEMENT area (either the Profile Valet tab or the Custom Profile Setup tab) Make sure a 

correct printer/paper profile is selected for your paper and applied. The name of the applied 

printer/paper profile is displayed to the right from “MEDIA MANAGEMENT” section name. If 

you did not click on the “Apply” button after selecting a profile, previously applied profile will 

stay in use. 

Output Profile Settings ImagePrint R.E.D.: In the ImagePrint Dashboard, in the PRINTER 

SELECTOR area make sure you are in the correct color management mode (typically “ImagePrint 

Manages Colors” and that you are set to the right profile in the Using Profile... menu. (If using a 

paper made by your printer maker, it should be Automatic--if using a 3rd party paper you should 

have the proper paper profile chosen.) Make sure the correct media type was selected in the 

Properties of the Windows Printer Driver – click on “Setup…” button to access the properties of 

the driver. 

Source Profile Settings: To confirm your source profile settings, in ImagePrint Preferences (found 

by choosing View in the Main Menu), choose Default Profiles tab and: 

- Make sure Embedded Profile Action is set to Apply (if you wish to see a prompt about an 

embedded profile, select Prompt, but you have to click “Yes” button every time you see a 

prompt about the embedded profile). NOTE: each image should contain the embedded source 

profile in properly colormanaged workflow. 
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- Make sure that your normal working spaces are selected in the Missing Profile/Untagged 

Images section for each color type. These will be used as defaults in the unlikely event when no 

embedded profile exists in an image. 

- The Simulation Setup profile should be NONE unless you are intentionally trying to match your 

output to a press or some other printer model. In almost all cases, when printing photography, 

leave this setting at NONE (The Intent setting won’t matter in such case). 

- The Colorized Profile (ImagePrint Black only) should be empty in most cases unless you are 

using a gray printer profile and want some portions of y our image to use the color profile 

selected here. This feature is supported for older Epson printer models. 

Profile temperature (ImagePrint Black only): Colored inks invariably show some differences 

when viewed under different lighting conditions. ColorByte makes multiple color profiles for 

each media we support in order to optimize the print for the environment it will be viewed in--

for best results, you should use a profile built for the lighting it will end up in. The two most 

commonly used profile temperatures are DAYLIGHT (targeting a daylight viewing environment) 

and Mixed Cool (F3) (targeting a cool white fluorescent mixed with daylight lighting 

environment). The Mixed Warm (F2) profile targets standard fluorescent mixed with daylight 

viewing environment). CWF is optimized for Cool White Fluorescent lighting and TUNGSTEN 

profiles are optimized for viewing under tungsten lighting. 

Images are not centered on the page 

In the following, orientation is always relative to the observer facing the front of the printer. 

For example, Top refers to the leading edge of the paper as it comes out of the printer, Left 

refers to the left edge of the paper as it comes out of the printer.  

• Top/bottom differences on sheet paper: Many printers by design have different top and 

bottom margins when using sheet paper. This can cause images to appear off center vertically 

when printed. (The Epson 2200, 2400, 3800, 3880, P600/800, P700/900 and Canon Pro 1000 

and 1100 are exceptions. These printers allow equal top/bottom borders on sheet, but all other 

Epson and Canon printers have a 1/8th inch top and 5/8ths bottom margin on sheet). To 

compensate for this limitation:  

If using ImagePrint Black you can choose Center Margins from the Printer Selector section of 

the Dashboard. This will cause the size of the smaller top margin to increase to that of the larger 

bottom mar gin, reducing the total printable area while compensating for the difference in 

margins. If you then choose to center your images, they should print with equal top and bottom 

borders, as long as images are short enough to fit within the white printable area of the page. 

Make sure to readjust any existing images on the page after changing this option, as the change 
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in layout size will shift things. The Centered Margins setting has no effect when set to ROLL 

paper.  

If using ImagePrint R.E.D. you will need to compensate for the difference in margins in the 

Windows Printer Driver for your printer. Consult your printer manual if not sure how to set that 

option for your printer.  

• Roll or sheet setting incorrect:  

ImagePrint Black: Make sure you have made the right selection for roll or sheet in ImagePrint 

(via the Roll/Sheet buttons in the PRINTER SELECTOR section of the Dashboard) or centering 

issues may result. Also, make sure that the correct TRAY option is selected in the PRINTER 

SELECTOR section of the Dashboard when printing on sheet paper. (Typical tray options are: ASF 

(Automatic Sheet Feeder), Manual, Front, or Back).  

If using ImagePrint R.E.D. Roll/Sheet options are specified in the Windows Printer Driver for 

your printer. Consult your printer manual if not sure how to set that option for your printer.  

• White border on images: Creating an image file with a white border around it is a common 

cause of centering problems. Remember, ImagePrint will treat the image in its entirety, and has 

no way of knowing that a white border is not part of the image. It will therefore place the image 

beginning at the edge of the white border, which may cause unexpected positioning results.  

• Paper size: Make sure that the actual size of the page you are printing on matches the page 

size specified in ImagePrint Black (or in the Windows Printer Driver if using ImagePrint R.E.D.). 

Surprisingly, papers some times are shipped from the manufacturer with slight size differences. 

These can result in non-centered printing. Measure the paper to ensure it is the correct size if 

you see an unwanted border. You can then use ImagePrint’s User Defined page size window to 

define a page size that exactly matches the physical dimensions of your paper.  

• Incorrect paper loading: How you load the paper in the printer can make a difference in the 

margins. Make sure that you are loading it according to the manufacturer’s instructions.  

• Printer margin set incorrectly: Many printers allow you to set the margin for roll paper on 

their front control panel. ImagePrint assumes this margin is at the lowest setting (typically 3 

mm) or the top and bottom roll paper margins are set to be equal (for newer printers, like Epson 

SC-P7500/9500 Series).  

I’m getting an unwanted margin on my borderless prints 

In the following, orientation is always relative to the observer facing the front of the printer. 

For example, Top refers to the leading edge of the paper as it comes out of the printer, Left 

refers to the left edge of the paper as it comes out of the printer. 
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Borderless not set: If you want to print without any margin at all, make sure that borderless 

mode is enabled. This is done in the PRINTER SELECTOR section of the Dashboard if using 

ImagePrint Black, or in the Windows Printer Driver itself if using ImagePrint R.E.D. (To access 

the Windows Driver in ImagePrint R.E.D. click the Setup... button in the Printers Selector of the 

Dashboard.  

Remember--most printers only allow full borderless printing on roll paper, not sheet, paper. Also, 

only certain paper widths will print with no borders. Check your printer manual for information 

on the borderless capabilities of your printer. Remember, if you see a pink border surrounding 

the layout area within ImagePrint then full borderless is not in effect. Full borderless mode will 

show no pink border.  

1/8th inch margin on left or right side: A border on the left or right side when attempting to 

print in borderless mode is usually an indication that the image is incorrectly positioned on the 

page. This can happen if you switched to borderless mode after you have positioned your image 

on the page. In that scenario, the layout area will have changed but the image will still be 

positioned at the edge of the original (bordered) area. Always reposition (or remove and 

reopen) your images after making changes to the borderless setting in either the Printer 

Selector section of the Dashboard (ImagePrint Black) or the Windows Printer Driver (ImagePrint 

R.E.D.).  

1 to 2 mm “hairline”: Most inkjet printers can vary as much as 2 millimeters in the way they 

position the edge of the paper. This can cause a thin line to appear on the edge of your full 

bleed prints. The “Global Printer Compensation” controls, available in the Preferences window 

of ImagePrint (found under the ImagePrint menu) can correct for this hardware variability. 

Setting a positive (right) or negative (left) X value will move the entire layout at print time and 

allow you to correct for these “hairline” issues.  

Cut Method for roll paper set incorrectly for Epson printer: If Normal cut method was left 

selected in Advanced Options in the Print Quality Settings in the Dashboard (ImagePrint Black) 

or in Windows Printer Driver (see Setup… in the Printer Selector in ImagePrint R.E.D.), then 

Epson printer will leave white non-printable margin on the leading and trailing edges of the 

print when cutting paper. Normal Cut should not be selected if 4-edge borderless is needed. 

I’m getting a wasted strip of paper between each print 

This usually means you are not set to the correct cut mode for your printer.  

For ImagePrint BLACK, that setting is in the Advanced Options window (accessed by clicking 

ADVANCED in the Print Quality Settings at the bottom of MEDIA MANAGEMENT section of the 

Dashboard).  
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For ImagePrint R.E.D. cut mode is set within the Windows Driver for your printer (if available).  

“Normal-cut” is usually the safest mode--you’ll get a small border at the end of your prints, but 

little to no waste. “Double-cut” mode will usually cut each page precisely at top and bottom, 

but it does result in a few inches of wasted paper between prints. “Single-cut” (for printers that 

support that option) attempts to cut borderless prints exactly at top/bottom without a wasted 

strip of paper between prints. Single-cut mode is often a bit finicky and, in our experience, often 

reverts to double-cut mode on many printers.  

My print is too long or too short 

ImagePrint Black: Print-length issues are typically due to problems with the printer’s paper 

feeding controls.  

Media Feed Adjustment (available for large format Epson printers): If available, increasing the 

Media Feed Adjustment setting (also in the Dashboard -> MEDIA MANAGEMENT -> Print Quality 

Settings -> Advanced button) can have the effect of lengthening the print by increasing the 

distance between printer passes. This slider rarely needs to be adjusted, but for very long prints 

on heavy papers (like canvas) it can help to compensate for problems with the printer’s paper 

feeding.  

Large format Canon printers have feed adjustment options on the front panel menu. See the 

printer’s manual for the instructions. 

ImagePrint R.E.D. Controls that affect print length of handled by the Windows Driver for your 

printer and can vary from printer to printer. 

The last few lines of my prints fade or don’t print  

Wrong paper size (length): This condition can be caused by an incorrect page size setting. If the 

page size you have selected is larger than the sheet loaded in the printer, the sheet may eject 

before the last bit of the image is printed. Measure the physical sheet to make sure it came 

from the manufacturer at the correct length--papers are often slightly smaller than the specified 

size (in which case you can specify a smaller page size in ImagePrint’s User Defined page size 

dialog box). 

Jobs print distorted or as negatives  

Layers: Flatten your image and try printing again.  

Channels: Prints that appear reversed or negative may be due to extra channels in the image 

(open the image in Photoshop and check, in the Channels window, that only the normal color 

channels appear)  
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Pixel Order: For Tiff files, make sure the PIXEL ORDER setting is interleaved (NOT “per channel”). 

This can be checked in the Photoshop SAVE dialog.  

Corrupt File: Rarely, a corrupted file can print with distorted results. Make sure to try printing a 

different file, such as one of the sample images within the TEST IMAGES folder within your 

ImagePrint folder.  

Nozzles: You may also get this result if there is a severely clogged nozzle. Do a nozzle check on 

the printer to ensure the nozzles are all clean.  

Incorrect Printer/Paper profile (ImagePrint BLACK only): Choosing a “Phatte black” profile 

when you are not using the Phatte black ink set can cause distorted prints, as can doing the 

opposite (printing with a non phatte black profile when you ARE configured for Phatte black).  

No source profile or incorrect source profile: If your images don’t have embedded profiles, 

make sure you have a valid profile setting for untagged/uncolormanaged images in the Default 

Profiles section of ImagePrint’s Preferences window.  

Prints show banding (lines) 

Nozzles: The first thing to check if you are experiencing banding issues is the nozzles of the 

printer. This is by far the most common cause of this problem. Even one missing or incorrectly 

firing nozzle can cause unpredictable banding. Run a nozzle check, and, if nozzles are missing or 

incorrectly aligned, run printer cleanings until it is corrected. (Note that ImagePrint, due to its 

enhanced ability to render detail, may show banding due to nozzle issue when the standard 

manufacturer’s driver doesn’t). 

Media Feed Adjustment:  

Media Feed Adjustment (available for large format Epson printers in ImagePrint Black): If 

available, decreasing the Media Feed Adjustment setting (also in the Dashboard -> MEDIA 

MANAGEMENT -> Print Quality Settings -> Advanced button) can help when thin white lines are 

visible between print passes.  

Large format Canon printers have feed adjustment options on the front panel menu. See the 

printer’s manual for the instructions. 

ImagePrint R.E.D. Look for a feed adjustment parameter in the Windows Driver for your printer 

(can vary from printer to printer). 

Low Print Quality Setting: If you see banding when printing at a lower print quality setting, 

select the highest quality setting. See the Dashboard -> MEDIA MANAGEMENT -> Print Quality 
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Settings -> Quality in ImagePrint Black or print quality setting in Windows Printer Driver 

(“Setup…” button in the Printer Selector section in the Dashboard window) in ImagePrint R.E.D. 
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Profiles 

I can’t find the paper profile I need (ImagePrint Black)  

First, make sure to select correct Black ink in the Profile Valet tab (Matte black - for matte media 

profiles and Photo black - for photo media profiles) in the Media Management section of the 

Dashboard window. If you don’t see a profile for the paper you are using in the Profile Valet, we 

may not have it. Send an email to the ColorByte Support dept. at 

imageprint_support@colorbytesoftware.com with the exact paper name, the printer you plan 

to use the profile with, and your 6-digit dongle number. We will check to see if we have the 

profile available (maybe we just haven’t uploaded it yet), and if we have the paper to make the 

calibration prints--if not, we may ask you to send us some of it so we can generate a profile. 

ColorByte may generate profiles for free if:  

We don’t already have a profile available  

The media you wish to have profiled is a valid one for your printer  

You can supply us with some of the paper (we will email the instructions) in perfect condition to 

use for the generation of the profile.  

IMPORTANT: Even if the above applies, we do not create profiles for uncoated papers, 

transparencies, or most “unusual” media such as metals.  

In some cases, rather than get samples of the media, we will ask you to output our profiling 

targets and send them to us--ColorByte will let you know exactly how to do that if it is 

necessary. 

I can’t find the paper profile I need (ImagePrint R.E.D.)  

ImagePrint R.E.D. does not supply paper profiles. Instead, it uses profiles made by the paper 

manufacturer. Check with your paper maker for the paper profiles for your particular media. 

Usually, they are downloadable from their website. Note that ImagePrint R.E.D. typically only 

needs the ICC profile--not the media configuration file the paper maker may offer.  

The profile should go in the standard location for profiles on windows. On most systems, you 

can simply right-click the ICC profile and choose to “Install” and Windows will place it in the 

proper location automatically. If you need to copy it in manually, the default location for profiles 

on Windows is:  

/Windows / System32 / Spool / Drivers / Color  

mailto:imageprint_support@colorbytesoftware.com
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Once the profile is in the proper location, it can be chosen in ImagePrint R.E.D. via the “Using 

Profile” menu in the Printer Sector section of the Dashboard. Remember, you’ll also need to 

select the correct Media Type for the paper you are using in your printer’s System Driver by 

clicking Setup... in the Printer Sector of the Dashboard. 

What are the LIGHTING designations within the profiles? (ImagePrint Black)  

The designations at the end of the printer/paper profile name refer to the lighting temperature 

the print will be best suited to be displayed in.  

Inkjet printers often exhibit color inconstancy (which is the characteristic of a print changing its 

appearance as it is moved to different lighting conditions) so ColorByte gives you a few choices 

to enable you to pick the conditions that most closely will match where the print will be viewed. 

(Although you can’t always know where a print will be viewed, having the ability to choose the 

temperature can make a big difference. If you know your print is going to viewed in a museum 

that uses Tungston lighting, you can pick the profile that will show it best there. If you are 

planning on hanging your print near a window, the Daylight profile would show it best.). 

The current temperature abbreviations are:  

TUNG Tungsten  

DAY Daylight (Most printer drivers only supply daylight optimized profiles, so this type may be 

best for an “apples to apples” comparison of ImagePrint prints to prints done via other 

methods).  

CWF Cool White Fluorescent  

F2 - Mixed Warm - profile targets standard fluorescent mixed with daylight viewing environment 

(this version is a bit less warm than our standard CWF profile, some people, especially portrait 

photographers, prefer it).  

F3 - Mixed Cool - targeting a cool white fluorescent mixed with daylight lighting environment. 

This the best profile to use for general lighting conditions, such as that found in offices. 

ImagePrint preview doesn’t match my image in Photoshop! (ImagePrint Black)  

This entry addresses the use of soft proofing within Photoshop to ensure the Photoshop display 

is compensating for the printer, ink and media being used when printing.  

By default, Photoshop does nothing to compensate for how an image can print on a given 

output device. It has no idea of the printer’s gamut, or the media (matte or gloss), or what ink 

you are using, or even the capabilities of the RIP--even though all of those factors have a 

tremendous effect on what colors and densities you will be able to print. Photoshop just 
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displays the image as best as it can within the gamut of the monitor. It’s therefore no wonder 

that Photoshop won’t automatically match the output of your printer, especially if you are using 

a RIP (like ImagePrint) that maximizes the output capabilities of the device rather than restrict it 

to a monitor-like color space.  

You can, however, tell Photoshop to use ImagePrint’s color profiles when creating its display, 

allowing you to work in a Photoshop environment that reflects more closely how ImagePrint will 

print your files. This is called Soft Proofing, and is done via the PROOF SETUP feature of 

Photoshop.  

To cause Photoshop to pass its display through ImagePrint’s printer profile, you must first copy 

the printer profile you are using in ImagePrint into the color profile folder used by Photoshop. 

While in ImagePrint, select the printer profile on Custom Profile Setup tab in Media 

Management section in the Dashboard and click on the “Install for Proofing” button and 

ImagePrint will copy that profile from its own Color folder into /Windows / System32 / Spool / 

Drivers / Color, where Photoshop can see it. If not using “Install for Proofing” button in 

ImagePrint’s Dashboard, you can copy the profiles in to place manually by right-clicking them, 

and choosing “Install” in the menu that appears. ImagePrint’s profiles can be located in 

C:\ProgramData\Colorbyte Software\ImagePrint 64bit\color folder. 

Once in place, this profile can be selected within Photoshop via Photoshop’s Proof Setup option. 

By choosing View->Proof Setup->Custom menu in Photoshop, you can select the Imageprint 

profile in Device to Simulate, causing Photoshop to bring it’s display within the gamut of the 

printer/paper/ink and RIP.  

Note: There are other options within the Proof Setup window that may or may not have an 

effect on matching your output (such as simulate paper white). The best way to determine 

which features to turn on is to print a sample image from ImagePrint, then compare it to the 

screen display of Photoshop with Proof Setup in effect. Try the different options, and use the 

ones that cause the dis play to most closely match the print. 

If you find that ImagePrint shows more shadow detail than you are used to in Photoshop, you 

can increase the darkness of the prints, at the possible expense of losing some shadow detail 

via the Shadow Point Compensation slider, located in the Image Properties section of the 

Dashboard window.  

 


